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Registration
After you begin using Blue Box Invoices and find out how easy it is to use, you’ll
probably want to register it.  At least I hope that you’ll want to register it.  This
program is designed to save you time and money, and I truly hope that it does.  If
you find that it doesn’t, feel free to stop using it, but if you find that it does, please
register it for the small fee of $20.00 (US).  To register, all you have to do is follow
the directions that appear when you open the program (the first screen—scroll
down to complete, print, and mail the form).  When your check is received, you
will be mailed (or e-mailed) a registration code that will unlock your copy of Blue
Box Invoices.  Note that I am trusting you here, and will not be holding the check
for 10 days to clear, I’ll be sending the code out right away.

Please support your fellow consultants!
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About Blue Box Software and Consulting
Blue Box Software and Consulting consists of Jay R. Kellett (that’s me) and
several associated companies and consultants.  We are about as small as they
come, but take great pride in the work that we accomplish.  The goal of Blue Box
Software and Consulting is to specialize in the field of software development for
training and performance support.  While most of our work is done on a contract
basis, it is our goal to develop and bring to market several tools that solve general
market needs.  If feel that we may be able to help you, please contact Jay R. Kellett
at (610) 738-0235, or write to:

Jay R. Kellett
Blue Box Software and Consulting
218 New Kent Drive
West Chester, PA 19380

You can also visit our web site at www.BlueBoxSW.com.

About Blue Box Invoices
Blue Box Invoices was created to allow consultants, contractors, freelancers, and
very small companies to quickly generate and track invoices.  It is aimed at being a
balance between "ease of use" and "general applicability" for all types of invoices.
Each invoice contains information about you or your company, information about
the client, and specific billing information.  Invoice information is broken out into
“Labor” and “Items.”  “Labor” relates to work done at an hourly wage, performed
on a specific date.  “Items” refers to anything else (usually with a fixed cost and
quantity associated with it).  This will be explained in more detail later.

Blue Box Invoices also has many features that allow you to look only at invoices
that relate to specific clients, and to pull information from them.  For instance, you
will be able to easily see how much of your revenues were generated from a
specific client— and how much of this has yet to be paid.

Thanks to the early users of Blue Box Invoices Version 1.0
Chris Kellett • Tracey Daniels • Michael Vagell • Eric Fletcher S.O.C. • Len Cooley • Douglas Tourtelot •
Nick Velharticky • Cole Camplese • Bill Burke • Jouni Välimaa • Eric DeBlackmere • Dan McCormack •
Vicki Silbert • David Wendlinger • Tobe Carey • Jeffery Wolfe • Brian Connell • Lou Judson • Bill Nesbitt •
Denny Furey • Adam White • John Cheak • C. Tucker • Monte Matteotti • Elizabeth J. Hanson • Don Zenz •
Charles Thomas • Chris Mansfield • Test • Jan Skorzewski • Dean Tomasula • Frank Scheidt • Allen Lannan •
Bob Hansmann • Richard Lo  • Ross Bishop • L. D. Ford • Brian Schultz • Roger M. Poor • John Berthet •
John Kane • Edison M. Cesar, Jr • Richard Luke • Richard L. Crawford • Jose Gonzalez • Craig Dial •
Bill Manning • Kenneth P. Frankel • Ira Goldman • Pam Atkins • Michael Goh • Reinhard • Olivier Diebold •
Christopher Arnold • Chris Benham • Richard Perry • Royce K. DeBow Sr. • Pat Glover • Robert E. Williams, Jr. •
Daly Jessup • David Whitehead • Matvey Palchuk  • Ian Scott-Parker • Todd VanVranken • Paul Ruspay •
Jonathan A. Duke • Ralph Isaacs • Robert Monk • Paul Ruspay • John A Horton • William Metzger • David Raffin •
Robert Fremault • Bill Byers • Al McGuire • Martin S. Zibulsky • Dr. Krystyna Isaacs • Al Hurlburt
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What’s New in Version 1.1?
This version has been guided by the feedback from users of version 1.0.  While we
couldn’t add everything, we think that we chose the features that will allow the
most users to get the most power out of this tool while keeping it as simple as ever
to use.

Major changes include:
• Taxes!  Probably the most requested feature.  BBI now allows you to

automatically add taxes to your invoices without ever having to pull out the
calculator ever again.  You may incorporate taxes in some or all of your
invoices, and may even use different rates for different invoices.

• Flexible Invoice Numbering.  You may now override the invoice number
generated by the program.  This has been requested by users who are migrating
from other systems, and by users who like to reflect clients or timeframes in the
numbering scheme.  You may skip numbers, back-number, and recycle
numbers if you so choose.

• Line Item Revenues.  Now you can link revenues directly back to specific line
items from the Labor database or the Items database.  Perfect for tracking
rentals or break-even points.

• Quarterly Tools.  Browsing invoices shows the quarter along with the date.
You can now find invoices within a specific year or quarter with a single mouse
click.

• Client Tools.  You can dial your clients using the modem, open an e-mail to
them, or go directly to their web site with a single click (Some of these options
vary with your system and configuration).

Upgrading from Version 1.0?
Check the install folder for a file called “upgrade.txt” which contains detailed
instructions for importing your 1.0 information into 1.1.  You should follow these
directions and back up your old data to a safe place.
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How it works

About the Databases
Blue Box Invoice is made up of four databases that work together to track invoice
information.  These databases are called Invoices, Clients, Labor, and Items
(when we refer to the database specifically, we’ll bold it).  It is important for you
to understand how they relate to each other in order to get the most out of this
program.

“Invoices” Database

The Invoices database is the central database where most things happen.  It is here
where you will enter new invoices, relate them to clients, enter your billing
information, and browse previously entered invoices.

“Clients” Database

The Clients database is where information about a specific client is stored.  When
you get a new client, you will come into this database and enter details about your
contact, the billing address, and other information.  It also allows you to come back
later and look at summary information about your client, including revenue totals
and invoice listings related to this client.

“Labor” Database

The Labor database allows set up default labor items, for quick entry into your
invoices later.  For instance, if your standard rate is $50.00/per hour and your
typically work day is 8 hours, you can enter a labor item called “Standard Day”
and include default values of $50.00 for the hourly rate, and 8 hours under “1x”
(single-time).  This will allow you to enter this labor-item later on your invoices
with a single click.

“Items” Database

The Items database allows you to enter default items which you might bill your
client for, which don’t relate directly to specific hours.  You can use this to enter
expenses encountered during the workday, milestone payments, or retainers.
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How They Work Together

The Invoices database is where most of the action happens.  After you enter
default values into the Labor and Items databases, these values become available
to you in the Invoices database.  When you enter clients, they too, become
available for selection within the Invoices database.  On a typical day you will be
able to enter the Invoices database, generate a new invoice, select the client, labor,
and items that apply, and print it without ever having to enter the other databases.

The Clients database is always working behind the scenes to keep track of your
clients, how much they have paid you, and how much they still owe you.

Printing happens from the Invoices database.  This allows you to print an
individual invoice and to print envelopes to mail it in.  Of course you can also print
multiple copies of the invoice for your records from here, too.

Labor Database

Invoices Database

Items Database

Clients Database

Print Invoice
Print Envelope



- 9 -

Understanding Databases and FileMaker Pro
If you are already familiar with the workings of databases and FileMaker Pro, you
can skip this chapter and move on.  If you are new to databases or FileMaker Pro,
you should at least breeze through this chapter so that you’ll be able to reference it
later if you need it.

About Databases

Databases, in general, are collections of similar types of information.  Inside
computers databases are formal structures of information with formal names for
each part.  Don’t let this scare you.  Once you get the hang of one database
program, you will find they all become familiar.  To explain the difference, let’s
assume that we have a phone book.  For our example, it will be a very small phone
book.  We open the phone book to the B’s, which only contains two entries:

B
Buffet, Warren 16 Value-Added Place 555-5555
Buffett, Jimmy 101 Parrot Lane 555-1234

In human terms, what we just did was open the phone book to the “B’s”, and
looked at what we found.  But in database terms, while we did the same thing,
there are more complicated terms to describe it.  First of all, since the phone book
is a collection of pieces of data, we would call the phone book a database.  Second,
when we opened the book to the “B’s” we performed what is called a “Find.”
Third, the information is arranged by alphabetical order by name.  This is called a
“Sort,” meaning that the data was sorted in an intentional manner (in this case,
alphabetically).

This is how things that are really simple become complex sounding-  “I browsed
the Sort of the Find from the Database” in this example is just a complicated way
of saying “I looked at the ‘B’s’ page in the phone book.”

Now let’s look at how we refer to specific pieces of information.  The building
blocks of databases are fields and records.  Together they define the structure of
the database- and frequently people confuse the two.  In our phone book example,
each line could be called a record.  Think of it as a set of data that belongs
together.  “Jimmy Buffett” lives at “101 Parrot Lane” and has the phone number
“555-1234.”  This is a record because it represents information that is supposed to
be connected, and has what we call a “one-to-one” relationship, meaning that
Jimmy Buffet has only one phone number, and the phone number has only one
owner, Jimmy.  The same could be said about the address.  So in our example, we
are looking at two records.
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Now let’s explain fields.  Fields are pieces of information that are represented in
each and every record.  There are three fields of information in our example, they
are “Name,” “Address,” and “Phone Number” (You could even argue that there are
four fields of information of you break “Name” into “First Name” and “Last
Name.”  For simplicity we won’t do this).  Think of our example it like this:

Name Address Phone Number
Buffet, Warren 16 Value-Added Place 555-5555
Buffett, Jimmy 101 Parrot Lane 555-1234

All records in a database have the same number of fields, since all fields are
represented in some way within each record, even records that fall outside of the
“B’s” (By the way, even if a field is blank inside of a record, it is still considered to
exist).

Now let’s say that we want to call our friend Jimmy Buffett to invite him to a
party.  It human terms, we are looking for his phone number, but in database terms,
we want to search for the record with the “Name” field equal to “Buffett, Jimmy”
and read the “Phone Number” field of that record.

Confused?  What we are really saying is that you want to use your finger to browse
the “Name” field (“Search for the Record”) until you find “Buffett, Jimmy” and
then move your finger over to the “Phone Number” column (read the “Phone
Number” field) to find his number.

Now let’s make things slightly more complicated.  Sometimes more than one
database is used so that information can be shared among the records.  Each record
in one database points to a record in another database.  This is called “Relating”
the records.  In a simple example, say there was another database that the Phone
Company stored billing information in that looked like this:

Phone Number Bill
555-0235 $65
555-1234 $50
555-1235 $40
555-5555 $35

Since both databases have the “Phone Number” field, we can use this field to relate
the databases.  If we need to know Warren Buffet’s phone bill, we can use our
phone book to look up his phone number (555-5555), and then use his phone
number to look up his bill ($35).
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The biggest advantage in relating information in this manner is that it allows you to
create “one-to-many” relationships.  In the invoicing program, we use this
technique to share client information among all invoices that are related to that
client.  This saves you the trouble of re-typing in most information (i.e., addresses)
and also allows you to quickly locate and analyze invoices related to a specific
client.
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Common Database Terms

Below is a listing of common database terms that you should be familiar with.
Refer back to this list if you are unsure what the term means when you encounter it
in this manual.
Database A grouping of multiple pieces of similar types of

information.  For instance, a phone book is a database of
names, addresses and phone numbers, where each listing has
one of each (a name, an address, and a phone number).

Record A single occurrence of a set of information.  In a phone
book, a record would consist of a name, address and phone
number.

Field A single piece of information that is represented within each
record.  In a phone book, each record contains three fields,
name, address, and phone number.

Screen or Layout The order in which information is arranged for the user.  A
database might display its information in a variety of
different layouts.  It is not necessary for a layout to show
each field within a record; some may be hidden but still exist
in the record.  A phone book only has one layout- columns.

Find The process of locating only certain records that meet
specific criteria.  Records that match the criteria are shown
and those that do not match are temporarily hidden.  If we
could take a phone book and locate only the entries that lived
on your street, that would be a “Find”.

Sort The process of taking records and organizing them based on
some criteria.  This might be done to a whole database or it
might be done only to records that were the result of a
“Find.”  If we took all of the entries from the phone book,
found the ones that lived on your street, and then arranged
them by house number- this would be a “Sort.”  Also a
phone book is the product of sorting all records by name.

Relate, Relating,
or Relational

The process of linking one record in a database to another
record in a different database, so that they can share
information.
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About FileMaker Pro

FileMaker Pro is the name of the database program that Blue Box Invoices is
developed in.  You do not need to own FileMaker Pro, since Blue Box Invoices is
packaged as a stand-alone application.  FileMaker Pro has some capabilities within
it, however, that compliment Blue Box Invoices and also some that are not directly
supported within Blue Boxes Invoices.  A brief explanation of the features of
FileMaker Pro follows.

Status area

The status area contains a brief overview of the database you are currently in.  The
status area always appears on the left side of the database.  Elements of the Status
area are:
• Screen Pop-up- This is an alternate way of changing screens within the

database.  Notice that Special screens (i.e., Print) do not appear on this menu.
• Flip-Book- This is a miniature flip-book that represents the database you are in.

You can use this by clicking either page to move forward to backward, or use
the tab on the right to move quickly through many records.  If you have
performed a Find, this book will only let you browse the found records.  To
undo this, select “All” from the “Find” row on the “Navigation Bar” while in
the “Browse” screen of the Invoices database.

• Records- Shows how many records are contained within the current database.
• Found- Only shows after performing a “Find.”  Tells you the number of records

you are browsing as a result of the find (not shown in diagram).
• Sorted Status- Tells you if the records you are browsing are sorted or not.

Screen Pop-up

Flip-Book

Records

Sorted Status
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The Menu Bar

The Menu Bar at the top of the screen allows you to access the built-in features of
FileMaker Pro.  Each menu is explained in more detail below.

File Menu

The following items are available from the file menu:
• Print Setup- This allows you to change features related to your printer.
• Print- This allows you to tell FileMaker to print a screen.  You should use the

“Print” available in the “Control Bar” instead.
• Import/Export- In general you should stay away from these features unless you

are familiar with the working of FileMaker Pro.
• Save a Copy- You should avoid using this feature since it will duplicate the

current database and may cause problems later
• Quit- This shuts down Blue Box Invoices and FileMaker pro, returning you to

your operating system.

Edit Menu

The following items are available from the Edit menu:
• Cut, Copy, Paste, and Clear- Use these to edit and move text inside of text

fields.
• Select All- Use this to select all text within a text field.
• Preferences (Application and Document)- In most cases you will probably not

need to adjust these, since they are already set-up properly.  The mostly likely
reason for changing these preferences would be if you wanted to configure your
modem to dial properly from the Clients database.

Mode Menu

You will not need any of the items found under this menu, since they duplicate
items found in the Control Bar and the New menu.

Select Menu

You will not need any items under this menu, since they duplicate items found in
the Control Bar.

Format Menu

These items may be used to modify text inside of text fields.  The following items
are available and usable in most (but not all) text fields:
• Font- Modify the font.
• Size- Modify the size of the font
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• Style- Add and modify the style of the font.
• Align Text- Align text within the field.
• Line Spacing- Change the spacing of the text.
• Text Color- Change the color of the text
• Text…- Modify many parameters of the text at once.
• Text Ruler- Add a text ruler and toolbar to the screen.  Allows placement of

tabs and adjustment of margins.

New Menu

These items allow the creation and deletion of records within a database.  These
commands are also available from the Control Bar.
• Invoice- Switches to the Invoice database and creates a new invoice record.
• Client- Switches to the Client database and creates a new client record.
• Labor- Switches to the Labor database and creates a new labor record.
• Item- Switches to the Item database and create a new Item record.
• Delete- Deletes the current record in the current database.  Be careful with this

option, as it can not be undone!

Window

Provides an alternate method of switching between databases.  You do not need
this since it is a duplicate of functionality found in the Control Bar.
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Installing the Program

Macintosh

Minimum Requirements

• Mac OS based computer, System 7.1 or later
• 8 megs of RAM
• 5 megs of free hard drive space

Set-up Instructions

• From the Blue Box web site (www.blueboxsw.com), download
“BBI-11.sit”.

• Expand this file with Stuff-It Expander (available at
www.aladdinsys.com).

• You should now have a folder called “Blue Box Invoices 1.1” on your hard
drive.

IBM-PC or Compatible

Minimum Requirements

• 486 or Pentium, Windows ’95 or above
• 8 megs of RAM
• 5 megs of free hard drive space

Set-up Instructions

• From the Blue Box web site (www.blueboxsw.com), download
“BBI-11.zip”.

• Expand this file with Win-Zip (available at www.winzip.com).
• You should now have a folder called “Blue Box Invoices 1.1” on your hard

drive.



- 17 -

The First Invoice

Opening the Program

To open to program, open the folder called “Blue Box Invoices” on your hard drive
and click on the application called “Blue Box Invoices.”  This will start the
program, and will open each database files for you.  Once this is done, the program
will show you an overview of all invoices entered into the system.  This is called
the “Browse” screen.

The Control Bar

Most navigation in this program is done using the control bar.  The control bar is
the collection of commands that appear at the top of the screen.  The command bar
has several rows that allow navigation and perform special functions.  These
functions change depending where you are in the program.

On the left of the first row of the control bar are the “Databases.”  This allows you
to switch among the four databases.  In order to change to a new database, just
click on the title.  The database you are currently in is colored in yellow, while the
available databases are colored in light blue.

On the right of the first row of the control bar are the “New” commands.  These
replicate commands in the “New” menu.  They can be used from any database to
create a new record in any database, including the one you are in currently.

The second row of the control bar is labeled “Screen.”  This allows you to switch
between the active screens within a database.  The Labor and Items databases
only have one screen, “Browse”.  The “Invoices” database has three user screens
and a special forth screen for printing (this screen is only used for printing).

Other special commands include “PrintEnvelope” and “Find” commands that come
up only on specific screens.  You can find more information on these commands in
the “Reference” section.

Entering Global Information

Before using the program to generate invoices, you need to enter information
specific to your company or business.  You do this by selecting the “Global”
screen from the Control Bar.
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All invoices are printed with a header and footer.  The header consists of a
100x100 pixel graphic logo, the company name, and the address.  The footer is a
large text area where you can add any supplemental information that all invoices
will need attached to them.  This might include your tax ID number, payment
terms, contact phone number, or any other pertinent information.  This text can be
formatted using the “Format” menu at the top of the screen.

You can replace any of the existing text by selecting it and typing over it.  You can
also paste the text in from another program if you prefer.  The graphic logo can be
replaced by:
• Copy a new logo from another source (scrapbook, etc).
• Select the box containing the logo on the “Globals” screen by clicking on it

once.
• Select Paste from the edit menu.
• Your new logo should appear in the box.

You may also set-up tax defaults from the Globals screen.  For more information
on the Globals screen, refer to the reference on page 24.



- 19 -

Entering Labor Records

After entering the “Globals” information, you should switch over to the Labor
database and begin filling out your standard labor items.  You can switch over by
selecting “Labor” from the “Databases” line of the “Control Bar.”

To create a new labor option (really a “record” in database terms), select “New
Labor” from the “New” menu or “New: Labor” from the control bar.  You should
create at least one record, and can create more if you like.  You can also modify an
existing option if you want.

For more information on the Labor database, refer to the reference on page 39.

Entering Items Records

Next you should begin entering items into your Items database.  This is similar to
the last set. Select “New Item” from the “New” menu.

For more information on the Items database, refer to the reference on page 40.
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Entering the First Client

Now that you have customized the database for your own use, you can begin
entering your clients.

Select “New Client” from the “New” menu.

For now, all you have to worry about is the contact information.  For more
information, refer to the Client database reference starting on page 35 or the
reference for this entry screen on page 36.
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Entering the First Invoice

You can enter a new Invoice by selecting “New Invoice” from the “New” menu.

You are now ready to begin entering the invoice information.  Since you have
already entered the Client information, all you have to do is select the correct client
from the pop-up menu (located to the right of the words “Client Index”).  This will
relate this invoice to the client, which will automatically fill in information such as
the client address and revenue information.

Next you should add labor and items information.  Use the pop-up menu to the left
of each line to fill it in.  Notice that each line is editable after it is filled in.  Also
notice that you will need to enter the correct date for each labor item in
MM/DD/YY format (the day-of-week is added for you automatically).  The grand
total will be calculated for you automatically as you enter the invoice information.
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Print Your Invoice

Now that you have entered the information, you will have to print out the invoice
so that you can send it to your client.  You do this by selecting “Print” from the
control bar.  This will pull together information from your “Globals” screen,
Clients database, and current invoice record to create an invoice, which is sent to
your printer.  If you need to select a new printer or want to print multiple copies,
you can select those options from the print dialog box that comes up.

Print an Envelope

OK, so now that you have your invoice, how do you mail it?  Simple, select the
“PrintEnvelope” screen from the control bar.  This will go to a special screen that
formats your header information into a return address and the client information
into a shipping address.  The result is sent to the printer.  You may have to change
your settings in the print dialog box to “manual feed” in order to correctly print on
the envelope.  All printers seem to handle this slightly different.  For more
information, see your printer’s manual.
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Your Next Invoice

Now that you have done all of the set-up for this program, future invoices should
be a breeze.  If you are sending out an additional invoice to a client already
entered, all you need to do is create a new invoice, relate it to that client, and begin
entering the invoice Labor and Items.  If you need to send an invoice out to a new
client, just enter the new client’s information first, and then create your new
invoice.  If you forget and create the invoice before entering the client:  No
Problem.  Just go back to the client database, enter the new client, and when you
return to the Invoices database, the new client will be available to you in the Client
Index field.
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All about the Invoice Database

Screens

The Invoices database has the following user screens:
• Globals- This screen allows you to control the Header and Footer information.
• Browse- This screen show you an overview of all invoices in the database.
• Entry- This screen allows you to enter, view, and modify information in an

invoice.

The Invoices database also has the following special screens that are available only
on the “Entry” screen:
• Print- When in the Entry screen, this screen formats the invoice and sends it to

the printer.  When in the Browse screen, the screen prints the list of invoices
that are currently being browsed.

• PrintEnvelope-Available only in the Entry screen, this screen allows you to
print out an envelope for mailing the current invoice.

Globals Screen

Each invoice that is printed has certain information that stays the same between
each invoice (i.e., your company name, address, payment instructions, etc.)
Globals allows you to setup and to change this information across all invoices.

This screen is divided into two main parts, header information and footer
information.  In the middle of the screen is a small diagram showing where the
information you enter would show up on an invoice.  This small invoice is a static
graphic and does not change as you enter information.
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Header Information

The header consists of a logo, company name, and address.  This information, as is
all of the information in Globals, is always identical for all invoices.

Logo

The default logo when you install the program is the Blue Box Software and
Consulting logo.  Obviously you don’t need to keep this, it is just a placeholder
until you find or create a logo of your own.  The logo that you use should be a
100x100 pixel graphic.  It can even be larger than this size, as the program will
scale it down to 100x100 when it needs to.  I don’t recommend this, because you
will just be taking up extra space in the database, and it will make your computer
spend more time processing the logo when you want to print.  If your logo is
smaller than 100x100 pixels, the program will just center the graphic in the box
and will not scale it.  This does not cause any problems when you print.  The logo
can be in color if you want it to be.  If you have a color printer, it should process it
just fine, and if you don’t, your printer will dither the image into a black and white
one as it prints.  Some printers do a better job of this than others.
To add a new logo you need to:
• Copy a new logo from another source (scrapbook, etc).
• Select the box containing the logo on the “Globals” screen.
• Select Paste from the edit menu.
• Your new logo should appear in the box.
If you want to clear the logo from the box, select the logo and select “Clear” from
the “Edit” menu.  This will erase the logo from all invoices.  You can always add
another logo after doing this.

Name and Address

The boxes to the right of the logo allow you to enter your company name and
address.  If you don’t need the extra line at the bottom, it is a nice idea to add you
phone number, too.  The first of the four lines is slightly larger and is bolded by
default.  You can change the styles and the fonts within these boxes to suit your
own taste.  Remember that the size of the boxes is fixed, and will not expand if you
add more text than will fit.  If you have an especially long name or address, try
reducing the size of the font from the “Format” menu.

Footer Information

The footer is really a box text box in which you can add any sort of information
that will be useful to people receiving your invoice.  Suggestions include:
• Directions on who to make payable on the check.
• Your tax ID number or social security number.
• Who to direct questions to, and the number to call.
• Your standard payment terms.
• A “Thank-You” for doing business with you.
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Tax Defaults

Each invoice has certain tax information stored within it.  New invoices are set-up
using the Tax Defaults in the Globals screen.  Changing these defaults does not
change existing invoices, only newly created ones.  Tax information of existing
invoices is modified in the entry screen.  There are 4 items you should set when
setting up your tax defaults:
• Labor Tax Method—This tells how taxes should be applied to labor items.

“No” means that no items are taxed.  “All” means that all labor items are taxed.
“Marked” means that only items whose descriptions contain the “Tax Marker”
are taxed.

• Items Tax Method— This tells how taxes should be applied to labor items.
“No” means that no items are taxed.  “All” means that all labor items are taxed.
“Marked” means that only items whose descriptions contain the “Tax Marker”
are taxed.

• Tax Rate—This is the rate at which to tax labor and items.  A single invoice can
only have one tax rate, but several invoices can have several different rates.

• Tax Marker—This is only used if Labor or Items Tax Methods are set to
“Marked.”  If so, any line that contains the Tax Marker in the description field
will have tax added to it.
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The Browse Screen

This screen allows you to browse all of your invoices.  It also allows you to search
for specific types of invoices, and to sort them.  Whenever you open a registered
copy of Blue Box Invoices, this is the screen that the program will open to.  When
opened, the program will show you all of the invoices and sort them by date (with
the most recent invoices at the top).

Each invoice is represented by a line of horizontal information containing select
fields.  Some of the headers on this screen are underlined, indicating that you may
sort the invoices by clicking on the header.  Some fields are also modifiable in this
screen.  Screen elements are:

Invoice Number

The automatically generated invoice identification number.  Invoices may be
sorted by invoice number by clicking on this header.

Purchase Order Number

The purchase order number from the client, if any.  Invoices may be sorted by
Purchase Order Number by clicking on this header.  This field is also modifiable.

Invoice Date

The date that the client was invoiced.  Invoices may be sorted by Invoice Date by
clicking on this header.  This field is also modifiable.

Company

Name of the company that was invoiced.  Invoices may be sorted by Company by
clicking on this header.

Total Labor Costs

Sum of all labor on the invoice.

Total Item Costs

Sum of all items on the invoice.

Taxes Total

The sum of “Total Labor Taxes” and “Total Item Taxes.”
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Grand Total

The sum of “Total Labor Costs” and “Total Item Costs.”

The Grand Total Header

This header is special because it also contains a dollar amount above it which
contains the sum of all invoices being browsed.  Notice that when you select a
Find, this total will change to reflect the dollar amount of the found set.

Paid

Either “Yes” or “No” indicating whether the invoice had been paid or not.
Invoices may be sorted by Paid status by clicking on this header.  This field is
modifiable by clicking on the checkbox next to the current Paid status.

The Go Button

Each invoice being browsed has a button to the right labeled “Go.”  This button
selects the invoice to which it is attached, and enters the “Entry” screen.

The Find Navigation

Unique to this screen is the “Find” items that appear at the bottom of the control
bar.  These entries allow you to quickly find a sub-set of the Invoices database.
After performing a Find, you may also want to perform a sort by clicking on one of
the underlined headers.  Each of the Find items performs the following functions:
• All- This finds all invoices in the system.  Frequently you will want to perform

this following another find.
• Paid- This finds all of your invoices that have been paid
• Unpaid- This finds all of your invoices that have not been paid.
• Omitted- This shows all of the invoices that were hidden as a result of the last

find, and hides all of the invoices that were shown as a result of the last find.
• 1998, 1999, and 2000—These will find all invoices in a specific year.
• Q1, Q2, Q3, and Q4—Two sets of these exist.  One after 1999 and the other

after 2000.  They will find all invoices within a specific quarter within the
specific year.
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The Entry Screen

The entry screen contains all of the information specific to one invoice at a time.
This information is broken up into five sections:
• Admin. Information
• Client Information
• Labor information
• Item Information
• Notes

Administration Information

The information that related to the processing and categorization of the invoice.
Fields of information are:

Invoice number

The serial number given to this invoice.  This number is in the standard Invoice
format.  The number shows both as a regular decimal and in the Invoice Number
Format.  The decimal number is modifiable and will automatically update the
formatted version when the cursor leaves the field.

Purchase Order Number

The number that relates to the purchase order from your client.  This number is
modifiable and is also optional.

Invoice Date

This reflects the date that your client was invoiced.  By default, this is the date on
which the invoice was created.  You may modify this field.

Paid

This designates whether the invoice has been paid by the client, or not.  You can
change the value by pressing the checkbox to the left of the “Yes” or “No” value.

Grand Total

This is the total dollar amount of the invoice.  This value is not directly modifiable
by the user, but updates itself as Labor and Items are added to the invoice.
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Invoice Tax Information

Labor Tax Method, Items Tax Method, Tax Rate, and Tax Marker  determine how
taxes are applied to this invoice.  For more information see Tax Defaults on page
26.

Client Information

These fields contain information related to the client being invoiced.  The
following field are found here:

Client Index

This field contains the client index number that has been related to this index.  The
information can be entered in two different ways, either by selecting the pop-up
menu (on top) or by typing in the client number (on bottom).  If you type the client
number in the box, it must be in the client number format in order for the system to
accept it.  You can press the “Go” button to jump to the “Client” database and
review this client information.

Client Mailing Address

When you select a client to relate to this invoice, the client’s address automatically
fills into this area.  While this field is not modifiable, you may still select this field
for purposes of copying the information out (to create a cover letter, for instance).

Client Revenues

These fields, “Paid,” “Unpaid,” and “Total” show you the amount of revenue
generated from this client, broken out by Paid status and also totaled.  You can
press the “Refresh” button to make sure that your latest changes to this invoice are
reflected in these totals.
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Labor Information

You can select your preset labor items from the pop-up menu to automatically add
them to this invoice.  Each of the twelve lines has it’s own pop-up menu.  Each line
also has a button labeled “X” which will clear the contents of that line.  You can
modify the contents of the line at any time, and do not have to first fill the line in
with information from the Labor database if you do not want to.

Total Labor costs will remain updated as you add and modify information.  “1x,”
“1.5x,” and “2x” allow you to enter regular time, time and a half, and double time
all within the same day.  Taxes, should they be applied to the line, will be shown at
the end.  Note that you will have to manually enter the date for each line, even if
you have filled the rest of the line in from the Labor database.

For more information on these labels, see the definitions from the Labor database
on page 39.

Items Information

Items information in filled in very similarly to the Labor information.  Each line
has a pop-up menu from which Items can be selected.  In order to clear the line,
press the “X” button to the left of the pop-up menu.  You can modify the
information at any time, and can manually fill in lines without first choosing them
from the Items database.  Taxes, should they be applied to the line, will be added
to the end.

For more information on these labels, see the definitions from the Items database
on page 40.
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Notes

Frequently you may have information that you want to attach to a specific invoice.
You can enter this information is the “Notes (Public)” field.  This information will
be shaded and attached to the invoice following the “Grand Total.”  This may
contain information about specific items, notes about follow up work, or
information to the billing department.  It is up to you how to use this field.  Notice
that the difference between this field and the “Footer” field is that the “Notes” field
applies to only a single invoice, while the “Footer” information applies to all
invoices.  Also notice the difference between this field and the Client Notes field,
which is not printed on invoices and is not shown to the client.
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Special Items on the Navigation Bar

The following are items which have a special function inside of the “Entry” screen.
These Items appear on the “Screen” Row of the Navigation bar.

Print

Selecting the “Print” screen while in the “Entry” screen will begin the invoice
printing process.  The program will use information from the Invoice, the Client
database, and the Globals to format and output the invoice to the printer.  The
program does it’s best to try to format the invoice into one page.  It will shrink the
Labor and Items list to the minimum size needed, and it will move up and shrink
the Notes field.  If it is unable to print the invoice out onto one page, it will output
a second page with the additional information.
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PrintEnvelope

A special Screen is added to the navigation bar inside of the Entry screen.  This is
the “PrintEnvelope.”  This option allows you to print an envelope for your invoice.
You will also notice that if you use the "Attn:" option in the client information, this
line will appear at the bottom of the address, and the client name and position will
not be shown.  This is to avoid confusion when sorting the mail.  You client's name
and position will still be printed normally on the invoice itself, however.
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All about the Client Database
The Client database allows you to enter and manage your client list.  This allows
you to enter client information once and then automatically fill-in that information
on invoices.  It also keeps track of how much revenue has come from each client
and how much they still owe you.

Remember, you always need to enter a client into the “Client” database before you
can invoice the client.

The Client Database has the following screens:
• Browse- this screen shows all of you clients and key fields about them.
• Entry- this screen allows you to enter, modify, and view all client information.
• Print- this special screen sends either the Browse screen or the Entry screen to

the printer.

Browse Screen

The browse screen shows all of your clients.  Each line contains key fields about
the client.  These fields are:
• Client Index- the client index number generated by the database, in standard

client number format.
• Description- a brief description of the client.  This field is arranged by

Company name, contact name, followed by title.
• Paid- the sum of all paid invoices related to this client.
• Unpaid- the sum of all unpaid invoices related to this client.
• Total- the sum of all invoices, paid and unpaid, related to this client.

The “Go” Button to the right of the Total allows you to select a client and to switch
to the Entry screen with a single click.  The double lined number that appears
above the Grand Total header shows all revenues from all clients.



- 36 -

Entry Screen

The Entry screen allows you do enter, modify and view information about an
individual client.

Client Index

This number is generated by the program and is in standard client index format.
The number is cannot be modified.  This is the number that the invoice database
uses to remember which client an invoice is related to.  Because this information is
used instead of a name, the contact, title, address, and other information can
change without harming older invoices.

Contact Name

This is the name of the person who is your contact at the company.  The invoice
will be mailed addressed to this person.  This field is optional.
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Contact Title

This is the formal title of the Contact Name.  This field is also optional.

Company

This is the name of the company that is being invoiced.  This field should be filled
in.  If the name of the company and the name of the person are the same, place the
name into this field.

Address

This is the address that the invoice should be mailed to.  You may use up to all
three in the address field.

City, State, and Zip

These fields allow you to enter the City, State and Zip of your client.  You should
use these fields instead of the Address lines so that the program can format your
address properly.

Attention

If this field is filled in, the name (or title or department) is added to the bottom of
the address with an extra line and the text “Attn:” before it.  This field is optional.

Phone (Voice) and Phone (Fax)

These are jextra places for you to track your client’s phone numbers.  You should
fill in the Voice phone number as it may help you later when shipping overnight
(FedEx requires a phone number on the shipping label).  You may also choose to
have your modem dial the phone number for you with the dial button.  You can set
up dialing preferences in the Application Preferences dialog box, under the “Edit”
menu.

E-mail Adress and Web Site

You can store your client’s E-mail address and Web Site in the spaces provided.
Assuming that your computer is configured properly for internet access, you can
use the buttons provided to open an email to the client, or to open their web site.

Mailing Address

This field is calculated by the database as you fill in the above information.  This
field is not modifiable, but can be selected and copied out into other programs.

Client Revenues

These fields, “Paid,” “Unpaid,” and “Total” show you the amount of revenue
generated from this client, broken out by Paid status and also totaled.  You can
press the “Refresh” button to make sure that your latest changes to this invoice are
reflected in these totals.  You will notice that this display looks similar to the
“Client Revenues” section of the Invoicing database.  The only difference here is
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that you can click on either “Paid,” “Unpaid,” or “Total” to quickly find all
invoices related to this client and to browse them in the Invoices database.

Client Notes

This allows you to enter notes on items not listed elsewhere about this client.
Suggested items include:
• Projects you have completed
• The client’s web site
• Information about the company
• Bidding information on future projects

Invoices

All invoices which have been related to this client can be browsed on the client
screen.  Select fields are used from each invoice. For more information on these
labels, see the definitions from the Labor database on page 39.
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All about the Labor Database

The Labor database allows you to enter labor information that you can fill out
invoices with a simple click.  You can create a new labor record by selecting “New
Labor” from the “New” menu.  Notice that the Date field is missing here, since that
is entered later.  The fields contained in each record are:

Labor Index

This is a standard number given to the record by the database.  You cannot modify
this number.

Description

This is the standard description the Invoice program will use when you select this
Labor record.  You can modify field this at any time.

Rate

This is the standard rate that will be used when you select this Labor record.  You
can modify this at any time.  The rate is an hourly rate.

1x, 1.5x, and 2x (The Hours)

These are the number of hours worked at different multipliers.  You enter straight
time under “1x,” time and a half under “1.5x,” and double time under “2x.”

Cost

This is a running total of the cost of the Labor record, assuming the default values.
This value is calculated as you modify the rate and the hours, and cannot be
modified.

Revenues

This is a running total of all revenues related to this type of labor.  This allows you
to get an idea of where your labor revenues are being generated.  If you want to
track specific types of labor related to a client, a special type of work, or work over
a specific time period, you should make separate labor items for each classification
so that there different totals will be tracked.
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All about the Items Database

The Items database allows you to enter items information that you can fill into
invoices with a simple click.  You can create a new Item record by selecting “New
Item” from the “New” menu.  The fields contained in each record are:

Item Index

This is a standard number given to the record by the database.  You can not modify
this number.

Quantity

This is the number of units that you are charging the client for.  You can modify
this field at any time.

Units

This is a text description of the units that are being invoiced.  You can modify this
field at any time

Description

This is the standard description the Invoice program will use when you select this
Items record.  You can modify field this at any time.

Unit Cost

The cost of one unit of this item.

Cost

This is a running total of the cost of the Labor record, assuming the default values.
This value is calculated as you modify the quantity and unit cost.

Revenues

This is a running total of all revenues related to this type of item.  This allows you
to get an idea of where your item revenues are being generated.  If you want to
track specific items related to a client, a single rental item, or specific items over a
time period, you should make separate items for each classification so that there
different totals will be tracked.
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All About Number Formats
Two number formats that you will see frequently in the program are the Invoice
Number Format and the Client Number Format.  They are explained below.

Invoice Number Format

The Invoice Number is used to tract each separate invoice.  The number always
appears in the Invoice Number Format, which is similar to the Client Number
Format.  The number is created at the time the record is created and cannot be
modified.  The number is used when relating invoices to clients and visa-versa.
The Invoice number always takes the form of the letter “I” followed by a period
(“.”), followed by four digits.  The numbers run in order, starting at 1 (shown as
“0001”) and counting upwards.
For example, these are all valid Invoice numbers:

• I.0001
• I.1234
• I.3000

Client Number Format

The Client Number is used to track each separate client.  The number always
appears in the Client Number Format, which is very similar to the Invoice number
format. The number is created at the time the record is created, and cannot be
modified.  The number is used when relating clients to invoices, and visa-versa.
The Client number always takes the form of the letter “C” followed by a periods
(“.”), followed by four digits.  The numbers run in order, starting at 1 (shown as
“0001”) and counting upwards.
These are all valid Client numbers:

• C.0001
• C.0101
• C.4321

All about the “New” Menu
The “New” Menu is available from all four database, and should be used when
creating new records in any of the databases.  Selecting an item from the “New”
menu will:
• Move you to the correct database if you are not already in it
• Put you in the correct screen for data-entry if you are not already in it
• Create a new record for you to begin entering information into.
• If you accidentally create a record you do not want, you can delete the current

record in your current database by selecting “Delete…” from under the “New”
menu.  Be careful as this can not be undone!
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Tips and Tricks

Importing a Logo

Aside from copying and pasting a logo into place, you can import a logo directly into the program.  This
keeps you from having to open the logo in a second application.  It will also allow you to “link” the log,
rather than importing it.  Large logos sometimes cause memory problems and are best linked rather than
imported.
To import, follow these directions:
• Go to the Invoices database.
• Go to the Globals screen.
• Click inside the Logo box.
• From the “File” menu, select “Import/Export…”
• From this pop-up menu, select “Import Picture”
• Select your image location.
• Choose “Link” if you want to keep the image outside of the program.
• Choose “Open.”
Your image should now be imported.  The image can be either PICT (Mac only), BMP (windows only),
GIF (both), or JPEG (both).

Dialing Preferences

If you choose to use the “Dial” button to phone your clients, you should set up the “Dialing” preferences.
These can be found by looking in the “Edit” menu for “Preferences” and opening the “Application”
preferences.  A pull down menu in the appearing dialog box will let have your computer recognize certain
prefixes and replace them with alternate prefixes.

Faxing Blue Box Invoices

If you wish to deliver your invoices by fax, you have two choices, you can either select to print to the fax
(Chooser on the Mac; Printers on Windows), or you can print a hard copy and fax it from a machine.
Some fax applications that add options to the “File” menu do not function properly with Blue Box
Invoices because they rely on over-riding the Print menu command.

International Concerns

International users have forwarded the following comments about the program.   If there are other things
that would need to change about the program in order to use it in your country, please let me know. A
new international version to address these issues in the planning stage.
• A4 paper needs to be supported
• Date format needs to switch to  “dd/mm/yyyy”
• Dollar sign should be customizable or removed
• Ability to customize text on Invoice

Why don’t my items stay in order?
When you enter Labor and Items into the invoice with pop-up menus, the items become organized
alphabetical order, not by reference number.  This means that the numbers will appear out of order, but
you can organize the list to appear in a logical order by naming similar items in a similar fashion (i.e.,
“Day Rate, Standard” and “Day Rate, Hazard”).
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Blue Box Software and Consulting License

PLEASE READ THIS LICENSE AGREEMENT ("LICENSE") CAREFULLY BEFORE USING THE
SOFTWARE.  BY USING THE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF
THIS LICENSE.  IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, DO NOT USE THE
SOFTWARE.

1. License.  The software and documentation accompanying this License, whether on disk, in read only memory, or
on any other media (the “Software”), are licensed to you by Blue Box Software and Consulting.  You own the disk
on which the Software is recorded but Blue Box Software and Consulting and its Licensor(s) retain title to the
Software.    This Software and any copies which this License authorizes you to make are subject to this License.

2. Permitted Uses and Restrictions.  This License allows you to use the Software one computer.  This License allows
you to make as many copies of the Software in machine-readable form as you need for backup purposes only.  You
must reproduce on such copy the Blue Box Software and Consulting copyright notice and any other proprietary
legends that were on the original copy of the Software.  You may also transfer your license rights in the Software,
the backup copy of the Software, the related documentation and a copy of this License to another party, provided the
other party reads and agrees to accept all the terms and conditions of this License.  The Software contains
copyrighted material, trade secrets and other proprietary material and in order to protect them you may not
decompile, reverse engineer, disassemble or otherwise reduce the Software to a human-perceivable form.  You may
not sublicense, modify, rent, lease, or create derivative works based upon the Software in whole or in part.  You may
not distribute the Software for profit in any form, including, but not limited to, electronic information service
distribution, bulletin board distribution, and magnetic or optical media distribution, except with the expressed
written permission of Blue Box Software and Consulting.  Non-profit distribution of the software is permissible
without prior written notice, providing that the Software is not modified in any way, and the complete works of the
Software are included in the distribution package.

3. Termination.  This License is effective until terminated.  You may terminate this License at any time by
destroying the Software and all related documentation and all copies thereof.  Your rights under this License will
terminate automatically without notice from Blue Box Software and Consulting if you fail to comply with any of the
term(s) of this License.  Upon termination you must destroy the Software and related documentation and all copies
thereof.

4. Export Law Assurances.  You agree and certify that neither the Software nor any other technical data received
from Blue Box Software and Consulting, nor the direct product thereof, will be exported outside the United States
except as authorized and as permitted by the laws and regulations of the United States.  If the Software has been
rightfully obtained by you outside of the United States, you agree that you will not re-export the Software nor any
other technical data received from Blue Box Software and Consulting, nor the direct product thereof, except as
permitted by the laws and regulations of the United States and the laws and regulations of the jurisdiction in which
you obtained the Software.

5. Government End Users.  If you are acquiring the Software on behalf of any unit or agency of the United States
Government, the following provisions apply.  The Government agrees that the Software shall be classified as
"commercial computer software" as that term is defined in the applicable provisions of the Federal Acquisistion
Regulation ("FAR") and supplements thereto, including the Department of Defense ("DoD") FAR Supplement
("DFARS").  If the Software are supplied for use by DoD, it is delivered subject to the terms of this License and
either (i) in accordance with DFARS 227.7202-1(a) and 227.7202-3(a), or (ii) with restricted rights in accordance
with DFARS 252.227-7013(c)(1)(ii) (OCT 1988), as applicable.  If the Software is supplied for use by any other
Federal agency, it is restricted computer software delivered subject to the terms of this License and (i) FAR
12.212(a); (ii) FAR 52.227-19; or (iii) FAR 52.227-14 (ALT III), as applicable.

6. Disclaimer of Warranty on Software.  You expressly acknowledge and agree that use of the Software is at your
sole risk.  The Software and related documentation is provided “AS IS” and without warranty of any kind and Blue
Box Software and Consulting and its Licensor(s) EXPRESSLY DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE.  BLUE BOX SOFTWARE AND CONSULTING DOES NOT
WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR
REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR
ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED.  FURTHERMORE, BLUE
BOX SOFTWARE AND CONSULTING DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS
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REGARDING THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE OR RELATED
DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE.
NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY BLUE BOX SOFTWARE AND
CONSULTING OR AN BLUE BOX SOFTWARE AND CONSULTING AUTHORIZED REPRESENTATIVE
SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY.
SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU (AND NOT BLUE BOX SOFTWARE AND
CONSULTING OR AN BLUE BOX SOFTWARE AND CONSULTING AUTHORIZED REPRESENTATIVE)
ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.  SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE
EXCLUSION MAY NOT APPLY TO YOU.

7. Limitation of Liability.  UNDER NO CIRCUMSTANCES INCLUDING NEGLIGENCE, SHALL BLUE BOX
SOFTWARE AND CONSULTING OR ITS LICENSOR(S) BE LIABLE FOR ANY INCIDENTAL, SPECIAL OR
CONSEQUENTIAL DAMAGES THAT RESULT FROM THE USE OR INABILITY TO USE THE SOFTWARE
OR RELATED DOCUMENTATION, EVEN IF BLUE BOX SOFTWARE AND CONSULTING OR AN BLUE
BOX SOFTWARE AND CONSULTING AUTHORIZED REPRESENTATIVE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.  SOME JURISDICTIONS DO NOT ALLOW THE LIMITATION OR
EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE ABOVE
LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.
In no event shall Blue Box Software and Consulting’s total liability to you for all damages, losses, and causes of
action (whether in contract, tort (including negligence) or otherwise) exceed the amount paid by you for the
Software.

8. Controlling Law and Severability.  This License shall be governed by and construed in accordance with the laws
of the United States and the State of Pennsylvania, as applied to agreements entered into and to be performed
entirely within Pennsylvania between Pennsylvania residents.  If for any reason a court of competent jurisdiction
finds any provision of this License, or portion thereof, to be unenforceable, that provision of the License shall be
enforced to the maximum extent permissible so as to effect the intent of the parties, and the remainder of this
License shall continue in full force and effect.

9. Complete Agreement.  This License constitutes the entire agreement between the parties with respect to the use of
the Software and related documentation, and supersedes all prior or contemporaneous understandings or agreements,
written or oral, regarding such subject matter.  No amendment to or modification of this License will be binding
unless in writing and signed by a duly authorized representative of Blue Box Software and Consulting.


